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Аннотация
Коротко о главном – такова особенность этого

издания, которое может стать настольной книгой для
начинающих пользователей ArchiCAD. Лаконично, доступно
и популярно излагаются основные сведения об этом
прикладном архитектурном пакете: описываются интерфейс,
команды, базовые операции. Книга предназначена для тех,
кто хочет получить знания в области проектирования и
создания архитектурных объектов, научиться решать реальные
практические задачи. Издание будет полезно новичкам,
желающим быстро освоить инструментарий ArchiCAD, а
опытным пользователям книга пригодится в качестве краткого
справочника по программе.
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Андрей Орлов
ArchiCAD. Начали!

 
Введение

 
Данное издание посвящено основным возможностям си-

стемы автоматизированного проектирования в области ар-
хитектуры и строительства ArchiCAD. Книга предназначена
прежде всего начинающим пользователям, поэтому матери-
ал приведен в том объеме и расположен в такой последова-
тельности, которые способствуют его быстрому освоению.

Глава 1 рассказывает о принципах разработки проекта в
ArchiCAD и основных возможностях системы.

В главе 2 рассматриваются элементы пользовательско-
го интерфейса рабочей среды программы и система помо-
щи, описывающая возможности, инструменты и технологии
ArchiCAD.

Главы 3 и 4 содержат принципы построения и редакти-
рования двумерных графических объектов с настройкой их
параметров и использованием механизмов точных построе-
ний. В них описаны способы выделения объектов, команды
изменения формы и относительного расположения графиче-
ских примитивов, методы привязки и группирования объек-
тов и способы их защиты от непреднамеренного изменения.



 
 
 

Материал главы 5 является краеугольным камнем для по-
нимания принципов проектирования в системе ArchiCAD.
Рассмотренные в ней объекты – стены, перекрытия, балки,
колонны и крыши – составляют основу любого архитектур-
ного проекта. Овладение настройкой параметров и методами
построения этих объектов позволит спроектировать любую
виртуальную конструкцию.

Глава 6 описывает работу с библиотечными объектами
ArchiCAD. Знание методов построения дверей и окон, лест-
ниц и объектов интерьера, источников освещения и прочих
элементов инфраструктуры здания поможет завершить об-
лик пользовательских проектов.

Завершает рассмотрение основных инструментов проек-
тирования описание слоев в главе 7. С их помощью пользо-
ватель может создать гибкую систему отображения объектов
проекта.

Остальная часть книги посвящена задачам оформления
чертежей, их визуализации и распечатке. В главе 8 рассмат-
ривается построение размерных и выносных надписей, глава
9 включает в себя описание методов создания деталировоч-
ных чертежей, рабочих листов и рисунков.

Завершает рассмотрение инструментов ArchiCAD глава
10, в которой описываются принципы и методы подготовки
чертежей, настройка устройств вывода и получение твердых
копий.

Приступим к знакомству с системой автоматизированного



 
 
 

проектирования ArchiCAD.



 
 
 

 
От главы коллектива авторов

 
Высказать замечания и пожелания, задать во-

просы по этой книге можно по адресу:
AlexanderZhadaev@sigmaplus.mcdir.ru или посетив нашу до-
машнюю страничку www.sigmaplus.mcdir.ru (здесь вы найде-
те также дополнительные материалы по книге, сможете при-
нять участие в форуме или пообщаться в чате).

Александр Жадаев



 
 
 

 
От издательства

 
Ваши замечания, предложения и вопросы отправляйте по

адресу электронной почты: dgurski@minsk.piter.com (изда-
тельство «Питер», компьютерная редакция).

Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете по-

дробную информацию о наших книгах.



 
 
 

 
Глава 1

Быстрый старт
 

Ни для кого не секрет, что в настоящее время работа кон-
структора с карандашом в руках считается анахронизмом.
Естественно, речь не идет о концептуальных набросках ге-
ниального архитектора, но использование кульмана при раз-
работке документации – самая худшая характеристика про-
ектной организации. Однако среди многочисленных автома-
тизированных систем, используемых в нашей стране, наибо-
лее популярными до сих пор являются так называемые уни-
версальные САПР, обеспечивающие построение чертежей
отрисовкой графических примитивов. Таким образом, уни-
версальные МАПР – это всего лишь электронные кульманы,
обеспечивающие минимальный уровень автоматизации про-
ектных работ.

В отличие от них ArchiCAD работает со строительными
конструкциями: стенами, окнами, балками, перекрытиями,
дверями, источниками освещения и т. д. Каждый из пере-
численных объектов имеет, естественно, чисто визуальные
параметры, необходимые для отображения объекта на чер-
тежах различного вида и масштаба. Кроме того, содержит
также сведения, определяющие его характеристики, напри-
мер материал объекта, его объем и площадь, позволяющие



 
 
 

подсчитать материальные затраты или построить реалистич-
ное объемное изображение. Свойства объекта определяют и
возможность его взаимодействия с другими объектами, на-
пример в стену можно вставить двери и окна, а балку под-
резать по скату крыши. Естественно, и процесс проектиро-
вания уже не сводится только к черчению, а приобретает со-
вершенно иные черты.

Давайте кратко рассмотрим основные этапы разработки
проекта в ArchiCAD.



 
 
 

 
Процесс проектирования в ArchiCAD

 
Можно определить следующие этапы разработки проекта

в ArchiCAD.
1. Построение виртуальной модели. На этом этапе созда-

ются планы этажей; определяются местоположение, форма
и взаимная ориентация несущих стен и перегородок; проек-
тируются двери и окна; кладутся балки и перекрытия; уста-
навливаются лестницы; проектируется крыша; размещаются
мебель и источники освещения; разводятся сети распреде-
лительных систем, то есть фактически строится виртуальная
модель проекта. Выполнить эту работу можно благодаря на-
личию в ArchiCAD инструментов трехмерного моделирова-
ния и библиотек объектов строительных и других элементов.

2. Оформление чертежей. На этом этапе строятся допол-
нительные виды (разрезы, фасады, трехмерные проекции и
т. д.), наносятся размеры и выносные надписи, условные обо-
значения, технические требования, проставляются отметки
уровней и прочие элементы оформления. Составляются спе-
цификации и сметы, готовятся презентационные материалы
для представления заказчику.

3. Подготовка комплекта проектной документации. Ко-
нечный итог разработки проекта – передача заказчикам или
смежникам проектной документации, которая может быть
подготовлена в электронном виде или в виде твердых копий,



 
 
 

то есть обычных бумажных чертежей и текстов. В ArchiCAD
разработчик может не только скомпоновать любые чертежи
из уже готового материала, но даже вообще не заниматься
этим делом, а поручить его менее квалифицированному со-
труднику, дав тому соответствующие указания.

Таким образом, при работе в ArchiCAD главным являет-
ся построение объемной модели разрабатываемого объекта,
включая детали его интерьера и окружающего пространства,
а подготовка документации – только необходимость, кото-
рую можно поручить техническим специалистам, не заня-
тым в проектировании напрямую.

Построение объемной модели имеет целью определить
структуру проекта, в результате чего появляется возмож-
ность получить необходимую информацию об объекте про-
ектирования. Использовать эти сведения можно в любом ас-
пекте: от проведения виртуальных экскурсий до разработки
и выполнения графика работ по возведению объекта.



 
 
 

 
Требования к аппаратно-

программному обеспечению
 

Поскольку ArchiCAD является программой, работающей
с трехмерными объектами, то требования, предъявляемые к
аппаратно-программному обеспечению компьютера, на ко-
тором предполагается установка этой САПР, достаточно вы-
соки.

 
Аппаратные требования

 
Аппаратные требования, предъявляемые к компьютеру

при установке программы ArchiCAD, следующие:
□ процессоры – Intel Pentium 4, Intel Centrino, Intel Core

Duo или совместимые; рекомендуемая тактовая частота – не
менее 2 ГГц;

□ оперативная память – требуется 1 Гбайт; для разработ-
ки сложных проектов рекомендуется более 1 Гбайт;

□ жесткий диск – установка полной версии ArchiCAD
требует 1 Гбайт свободного пространства; не менее 2 Гбайт
требуется для разработки сложных проектов с трехмерной
визуализацией;

□ монитор – минимальное разрешение 1024 х 768 точек;
рекомендуется 1280 х1024;

□ видеокарта – с поддержкой технологии OpenGL и ми-



 
 
 

нимальным объемом видеопамяти 64 Мбайт; рекомендуется
не менее 128 Мбайт.

ПРИМЕЧАНИЕ
Для знакомства с основными возможностями

системы можно установить ArchiCAD и на компьютер
с более скромной конфигурацией, но процесс
разработки проектов, достаточно сложных по объему
и степени детализации, в этом случае будет
малопроизводительным.

 
Программные требования

 
Программные требования к компьютеру при установке на

него программы ArchiCAD следующие:
□ операционная система – Windows XP Pro или Vista

Business / Enterprise / Ultimate Edition;
□ поддержка Java 1.6.0 или более поздняя;
□ проигрыватель – QuickTime, версия 7 или более позд-

няя.
ПРИМЕЧАНИЕ
В процессе работы программа установки ArchiCAD

проверяет наличие необходимого программного
обеспечения и при его отсутствии самостоятельно
устанавливает поддержку Java-версии 1.6.0 и
проигрыватель QuickTime 7.



 
 
 

 
Запуск ArchiCAD

 
Процесс установки ArchiCAD прост и не требует особых

знаний. Не будем останавливаться на нем подробно, а пред-
положим, что программа уже установлена на рабочем ком-
пьютере.

Для запуска программы ArchiCAD нужно выполнить од-
но из следующих действий:

□ выполнить команду Start ► All Programs ► Graphisoft
► ArchiCAD 11 ► ArchiCAD 11 (Пуск ► Все программы ►
Graphisoft ► ArchiCAD 11 ► ArchiCAD 11) главного меню
Windows;

□ дважды щелкнуть кнопкой мыши на ярлыке программы
ArchiCAD

расположенном на Рабочем столе компьютера;
□ дважды щелкнуть кнопкой мыши на значке программы,

расположенном на панели быстрого запуска;
□ дважды щелкнуть кнопкой мыши на одном из файлов

проекта ArchiCAD.
ПРИМЕЧАНИЕ
Второй и третий способы будут доступны, если

создание используемых ярлыков было предусмотрено



 
 
 

при установке ArchiCAD. В противном случае
можно самостоятельно создать необходимые ярлыки,
используя стандартные средства Windows.

Прежде чем рассматривать процесс запуска ArchiCAD,
нужно определить понятие «проект». Под проектом понима-
ется совокупность всех элементов конкретной разработки:
построенные объекты виртуальной модели здания, создан-
ные чертежи и рисунки, различные виды. Другими словами,
проект – это все, что является итогом труда разработчика, и
кроме того, это все настройки среды разработки: свойства и
атрибуты элементов, состав и расположение панелей инстру-
ментов, ссылки на используемые при разработке библиотеч-
ные объекты и т. п. Все составляющие элементы проекта со-
храняются в едином файле с расширением PLN.

При первом запуске ArchiCAD на экране появится окно
Start ArchiCAD (Запуск ArchiCAD) (рис. 1.1).

Окно запуска разделено на пять областей. В верхней ча-
сти окна расположен переключатель выбора режима запуска,
который можно установить в одно из трех имеющихся поло-
жений. Выбор любого из этих положений изменяет состав
доступных элементов управления.



 
 
 

Рис. 1.1. Выбор параметров проекта при запуске



 
 
 

ArchiCAD

Установка, используемая по умолчанию, – Create a New
Project (Создать новый проект). При выборе этого положе-
ния во второй области окна станет доступным переключа-
тель Set up Project Settings (Установить параметры проекта),
предназначенный для выбора шаблона настроек элементов
проекта. Настройки включают в себя определения типов ли-
ний, единиц измерения, рисунков штриховок и прочих па-
раметров элементов проекта, сохраненных в файле с расши-
рением TPL.

Если установить переключатель выбора режима запуска
в положение Open a Project (Открыть проект), то во второй
области окна вместо переключателя Set up Project Settings
(Установить параметры проекта) появляется переключатель
You can (Вы можете), который можно установить в следую-
щие положения:

□ Browse for a Project (Выбрать проект) – при выборе
этого значения кнопка New (Новый) заменяется кнопкой
Browse (Просмотр), нажатие которой открывает навигацион-
ное окно файловой системы Windows, используя элементы
управления которого можно выбрать для открытия необхо-
димый файл;

□ Select a recent Project (Выбрать последний проект) –
предназначено для открытия одного из последних редакти-
ровавшихся проектов, список которых становится доступ-



 
 
 

ным для выбора; кнопка Browse (Просмотр) в этом случае
заменяется кнопкой Open (Открыть).

Третье положение переключателя выбора режима запуска
– Sign In to a Team Project (Присоединиться к совместному
проекту) – предназначено для коллективной работы, кото-
рая в данной книге подробно не рассматривается.

В третьей области окна можно выбрать профиль рабочей
среды. Профилем называется совокупность настроек эле-
ментов интерфейса, к которым относятся состав и положе-
ние меню, размещение и состав панелей инструментов, окон,
настройки цветовой палитры, места размещения файлов и т.
д. Требуемый профиль выбирается из открывающегося спис-
ка.

В четвертой области расположены кнопки, одна из ко-
торых, используемая для открытия проекта, описана выше,
другая – Qiut ArchiCAD (Покинуть ArchiCAD) – предназна-
чена для прерывания запуска программы.

При установке флажка Do not Display this Dialog Next
Time (Не показывать этот диалог при следующем запуске),
расположенного в последней области, рассматриваемое ок-
но при запуске ArchiCAD показываться не будет. Функции
создания и открытия проекта, выбора шаблонов и профилей
в этом случае будут доступны с помощью соответствующих
инструментов рабочей среды ArchiCAD.

При самом первом запуске нужно, естественно, оставить
все установки по умолчанию. Нажатие кнопки New (Новый)



 
 
 

приведет к созданию нового проекта, открытого в рабочей
среде программы ArchiCAD (рис. 1.2).

О том, как сориентироваться в пользовательском интер-
фейсе ArchiCAD, см. в гл. 2. Сейчас рассмотрим основные
инструменты, с помощью которых можно создать проект,
сохранить его, а затем открыть для последующего редакти-
рования. Эти инструменты хорошо известны пользователям
большинства программ Windows.



 
 
 

 
Создание, сохранение
и открытие проекта

 
Создать новый файл проекта можно с помощью одного из

следующих действий:

Рис. 1.2. Рабочая среда программы ArchiCAD

□ нажать кнопку



 
 
 

расположенную на панели инструментов Standard (Стан-
дартная);

□ выполнить команду File ► New (Файл ► Создать) меню
ArchiCAD;

□ нажать комбинацию клавиш Ctrl+N.
СОВЕТ
Рассматриваемая в книге оригинальная версия

ArchiCAD чувствительна к установленной раскладке
клавиатуры. Если нажатие комбинации клавиш не
приводит к необходимому эффекту, то, возможно, у
вас активна кириллица. Переключитесь на английский
язык. В локализованной версии программы эта
проблема отсутствует.

Для сохранения редактируемого проекта можно исполь-
зовать следующие способы:

□ нажать кнопку

расположенную на панели инструментов Standard (Стан-
дартная);

□ выполнить команду File ► Save (Файл ► Сохранить)
меню ArchiCAD;

□ нажать комбинацию клавиш Ctrl+S.



 
 
 

После выбора действия по сохранению проекта появляет-
ся навигационное окно Windows, используя элементы интер-
фейса которого необходимо выбрать место расположения и
ввести имя файла, под которым будет сохранен проект.

Выше было упомянуто о возможности сохранения проек-
та ArchiCAD в форматах других программ. Для этого пред-
назначена команда главного меню File ► Save as (Файл ► Со-
хранить как) или комбинация клавиш Ctrl+Shift+S. Выпол-
нив одно их этих действий, пользователь получит возмож-
ность выбрать из списка типов файлов навигационного окна
(рис. 1.3) необходимый формат сохраняемого проекта.



 
 
 

Рис. 1.3. Сохранение файла проекта в другом формате

Чтобы открыть существующий проект, нужно выполнить
одно из следующих действий:

□ нажать кнопку



 
 
 

на панели инструментов;
□ выполнить команду File ► Open (Файл ► Открыть) ме-

ню ArchiCAD;
□ нажать комбинацию клавиш Ctrl+0.
Из соответствующих списков открывшегося навигацион-

ного окна необходимо выбрать имя и тип открываемого фай-
ла проекта. По умолчанию файлы с сохраненными проекта-
ми имеют расширение PLN.

В окне программы можно одновременно работать только
с одним проектом. Если необходимо открыть несколько про-
ектов, то нужно запустить соответствующее количество ко-
пий ArchiCAD, в каждой из которых открыть свой проект.



 
 
 

 
Варианты сохранения проекта

 
По умолчанию проект ArchiCAD сохраняется в формате

PLN, но при этом в файл проекта записываются только ссыл-
ки на использованные в проекте библиотечные объекты, тек-
стуры и фоновые рисунки. По этой причине при переносе
файла проекта на другой компьютер эти объекты исчезнут.
Чтобы сохранить полную информацию проекта, необходимо
выбирать формат PLA.

Проект, включая значения параметров его инструментов
и объектов, можно сохранить в виде шаблона, файл которого
имеет расширение TPL. На базе имеющихся шаблонов мож-
но создавать другие проекты.

В проект можно вставлять содержимое других проектов
или файлов. Объем сохраняемого файла можно уменьшить,
используя сжатие.

Обо всем вышесказанном можно прочесть на странице
системы помощи программы, где в левой части окна на
вкладке Содержание в древовидном списке нужно открыть
папку Configuration (Конфигурация), а в ней найти папку
Managing Projects (Управление проектами). Чтобы попасть
на страницу помощи, следует выполнить в главном окне про-
граммы команду Help ► ArchiCAD Help (Помощь ► Систе-
ма помощи).

Подробное описание форматов для сохранения файла



 
 
 

проекта можно найти на этой же странице, если открыть в
левой части окна папку User Interface Reference (Справочник
по интерфейсу пользователя), в ней перейти в папку Dialog
Boxes (Диалоговые окна) и выбрать здесь файл File Types
Saved by ArchiCAD (Типы сохраняемых файлов).

В первой главе основное внимание было уделено описа-
нию возможностей этой системы и тех преимуществ, ко-
торые получает разработчик по сравнению с ручным про-
ектированием или работой в среде универсальных САПР.
В главе приведены требования к аппаратно-программному
обеспечению, необходимому для установки и эксплуатации
ArchiCAD, описан процесс запуска системы с выбором ва-
риантов загрузки, дано понятие проекта и рассмотрены дей-
ствия по его созданию, сохранению и открытию.



 
 
 

 
Глава 2

Знакомство с рабочим окном
и инструментами ArchiCAD

 
Пользователь взаимодействует с программой с помо-

щью элементов управления, совокупность которых называ-
ется графическим интерфейсом пользователя. В интерфейсе
ArchiCAD используются стандартные элементы управления,
знакомые любому пользователю Windows, поэтому освоение
программы не вызовет серьезных затруд нений.

Загрузите программу ArchiCAD одним из рассмотренных
в главе 1 способов, используя настройки, установленные по
умолчанию, то есть нажимая кнопку ОК в любом окне, отоб-
ражаемом при загрузке программы. По окончании загрузки
на экране отобразится стартовое окно ArchiCAD (рис. 2.1).

Рассмотрим эти элементы более подробно.



 
 
 

 
Главное меню

 
Принцип действия главного меню ArchiCAD (рис. 2.2)

не отличается от меню любой другой программы Windows.
Щелчок на меню открывает подменю и команды, предостав-
ляющие доступ к инструментам и функциям программы.

Главное меню ArchiCAD включает множество команд,
с которыми мы будем работать на протяжении всей кни-
ги. Для быстрого вызова наиболее часто употребляемых ко-
манд предусмотрен механизм использования горячих кла-
виш. Просмотреть полный список действующих в среде про-
граммы горячих клавиш можно, выполнив следующую по-
следовательность действий.

1. Выполните команду главного меню Options ► Work
Environment ► Keyboard Shortcuts (Параметры ► Рабочая
среда ► Горячие клавиши) – откроется окно настройки ра-
бочей среды ArchiCAD Work Environment (Рабочая среда)
с активным пунктом Keyboard Shortcuts (Горячие клавиши)
(рис. 2.3).

2. Нажмите кнопку Show Shortcut List in Browser (Пока-
зать список горячих клавиш в браузере), расположенную в
разделе Keyboard Shortcut Preview (Просмотр горячих кла-
виш), который находится внизу правой части окна настрой-
ки рабочей среды. В окне браузера, установленного в опера-
ционной системе по умолчанию, откроется список горячих



 
 
 

клавиш среды ArchiCAD (рис. 2.4).

Рис. 2.1. Элементы интерфейса ArchiCAD

Рис. 2.2. Элементы главного меню ArchiCAD



 
 
 

Рис. 2.3. Окно настройки рабочей среды ArchiCAD



 
 
 

Рис. 2.4. Список горячих клавиш ArchiCAD



 
 
 

 
Панели инструментов

 
Панель инструментов – область графического интерфей-

са, содержащая элементы управления, выполненные чаще
всего в виде кнопок, с помощью которых можно вызвать
необходимую команду или меню. С ArchiCAD поставляется
15 предварительно настроенных панелей инструментов. Мы
будем знакомиться с панелями на протяжении всей книги,
используя их по мере надобности.

Для включения / выключения отображения необходимых
панелей инструментов выполните команду меню Window ►
Toolbars (Окно ► Панели инструментов) и в отобразившем-
ся списке панелей инструментов щелкните кнопкой мыши на
наименовании необходимой панели. Слева от названия па-
нели появится значок, свидетельствующий о ее активности,
а сама панель отобразится на экране. Если щелкнуть на ак-
тивной панели, то она отключится.

Вид панели инструментов зависит от ее положения. Если
панель находится у границы окна ArchiCAD, то она притя-
гивается к границе и располагается вдоль нее. В верхней ча-
сти вертикально расположенной панели и у левого края го-
ризонтально расположенной панели находится заголовок па-
нели, имеющий вид линии, состоящей из точек. При поло-
жении панели инструментов внутри окна ArchiCAD или за
его пределами панель имеет вид окна Windows.



 
 
 

Заголовок панели инструментов предназначен для ее пе-
ремещения по экрану. Чтобы изменить место расположения
панели, щелкните кнопкой мыши на области заголовка и, не
отпуская кнопку мыши, перетащите панель на новое место.



 
 
 

 
Палитры

 
Как и панели, палитры предназначены для размещения

различных элементов управления, поэтому принципиально-
го различия между этими элементами пользовательского ин-
терфейса нет. Основное отличие между панелями инстру-
ментов и палитрами в том, что последние содержат более
разнообразные инструменты и, следовательно, имеют более
гибкие возможности управления ими и собственным внеш-
ним видом.



 
 
 

 
Конец ознакомительного

фрагмента.
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